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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 10.0 to support Charter
Spectrum Enterprise SIP Trunking Service on legacy Charter Communications Platform.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

The Charter Spectrum Enterprise SIP Trunking Service on legacy Charter Communications
Platform provides PSTN access via a SIP Trunk between the enterprise and the legacy Charter
Communications network as an alternative to legacy analog or ISDN-PRI trunks. This
approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Legacy Charter Communications is a member of the Avaya DevConnect Service Provider
Program. Information in these Application Notes has been obtained through DevConnect
compliance testing and additional technical discussions. Testing was conducted via the
DevConnect Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between the legacy Charter Communications Platform and an Avaya SIP-
enabled enterprise solution.

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consisted of
Avaya IP Office 500 V2 Release 10 (hereafter referred to as IP Office), Avaya Communicator for
Windows, Avaya Communicator for Web and Avaya Deskphones, including SIP, H.323, digital, and
analog.

For brevity, from this point forward, the “Charter Spectrum Enterprise SIP Trunking Service on
legacy Charter Communications Platform” will be referred to as the “Charter SIP Trunking Service”.
The terms “service provider”, “Charter” or “Charter Communications” will be used interchangeably
throughout these Application Notes, referring to the “legacy Charter Communications” company

As a required component of the Charter SIP Trunking Service offering, Charter will install a
Modular Access Router at the customer premises (enterprise site). Charter will perform the initial
configuration and maintenance as required. The Modular Access Router will be considered
Customer Premises Equipment (CPE).

The Charter SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the Avaya IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This converged
network solution is an alternative to traditional PSTN trunks such as analog and/or ISDN-PRI
trunks. This approach generally results in lower cost for the enterprise.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Solution & Interoperability Test
Lab by connecting IP Office to the Charter SIP Trunking Service via the public Internet, as depicted
in Figure 1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.
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2.1 Interoperability Compliance Testing

To verify the Charter SIP Trunking service offering with Avaya IP Office, the following features and
functionalities were exercised during the compliance testing:

Response to SIP OPTIONS queries.

Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital and analog at
the enterprise. All incoming calls from the PSTN were routed to the enterprise across the SIP
Trunk from the service provider networks.

Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephone at the enterprise. All outgoing calls to the PSTN were routed from the enterprise
across the SIP trunk to the service provider networks.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Windows.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Web.

Dialing plans including local, long distance, outbound toll-free and international.

Caller ID presentation and Caller 1D restriction.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with coverage to voicemail
off).

Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Codec G.711MU (Charter supported audio codec).

Proper response to no matching codecs.

G.711 Fax Pass-through.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages, etc.).

Outbound Toll-Free calls, interacting with IVVR (Interactive VVoice Response systems).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:

The use of the SIP REFER method for network call redirection is not currently supported by
Charter.

Inbound toll-free calls and 911 emergency calls are supported but were not tested as part of
the compliance test.

T.38 fax is not supported by Charter; therefore, T.38 fax was not tested.
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2.2 Test Results

Interoperability testing with Charter SIP Trunking service was successfully completed with the
exception of observations/limitations described below:

e (.711 Fax Pass-Through: G.711 fax pass-through calls failed intermittently. Inbound fax
calls from the PSTN to IP Office and outbound fax calls from IP Office to the PSTN failed
intermittently. This issue is believe to be network related, thus this issue is not necessarily
indicative of a limitation of the combined Avaya/Charter solutions. It’s listed here simply as
an observation.

e Call Display on Transferred Calls to PSTN: Caller ID display is not updated on PSTN
phones involved with call transfers from IP Office to the PSTN. After the call transfer is
completed, the PSTN phone does not display the number of the actual connected party but
instead shows the number assigned to the extension in IP Office that initiated the call
transfer. The PSTN phone display is ultimately controlled by the PSTN provider, thus this
behavior is not necessarily indicative of a limitation of the combined Avaya/Charter solution.
It is listed here simply as an observation.

e Inbound calls to an unassigned enterprise extension: IP Office sends a “404 Not Found”
message to the Charter network when it receives calls to an unassigned extension, the user
hears re-order instead of the common announcement informing the user that he/she has
reached a non-working number, to please check the number and to try again. This issue is
considered non service affecting.

2.3 Support

For support on Charter Spectrum Enterprise SIP Trunking Service visit the corporate Web page at:
https://business.spectrum.com/content/sip-trunking or call 888-692-8635.

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration
Figure 1 illustrates the test configuration used. The test configuration simulates an enterprise site

with an Avaya SIP-enabled enterprise solution connected to the Charter SIP Trunking service
through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
Avaya IP Office 500 V2.

Avaya IP Office Voicemail Pro.

Avaya IP Office Application Server.
Avaya 96x1 Series H.323 IP Deskphones.
Avaya 1100 Series SIP IP Deskphones.
Avaya Communicator for Windows.
Avaya Communicator for Web.

Avaya 1408 Digital Telephones.

Avaya 9508 Digital Telephones.

Analog Deskphones.
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In the reference configuration, a Modular Access Router was required at the simulated enterprise
site, acting as a SIP interface between the Avaya enterprise (IP Office) and Charter’s network.
Charter will install the Modular Access Router at the customer premises (enterprise site). Charter
will perform the initial configuration and maintenance as required. The Modular Access Router will
be considered Customer Premises Equipment (CPE).

Also located at the simulated enterprise site is Avaya IP Office 500 V2 with analog and digital
extension expansion modules, as well as a VCM64 (Voice Compression Module) for supporting
VoIP codecs. The IP Office LANL1 port connects to the inside interface (or private side) of Charter’s
Modular Access Router.

The transport protocol between IP Office and Charter’s Modular Access Router, across the
enterprise private IP network, is SIP over UDP.

For inbound calls, the calls flowed from Charter’s network, across the public Internet, to Charter’s
Modular Access Router, then to IP Office.

Outbound calls to the PSTN were first processed by IP Office. Once IP Office selected the proper
SIP trunk; the call was routed to Charter’s Modular Access Router, across the public Internet, to
Charter’s network.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls across
the SIP trunk to Charter (refer to Section 5.8). The short code 9 was stripped off by Avaya IP Office
but the remaining N digits were sent unaltered to the network. Since Charter is a U.S. based
company, a country member of the North American Numbering Plan (NANP), the users dialed 7 or
10 digits for local calls, and 11 (1 + 10) digits for other calls between the NANP.

In an actual customer configuration, the enterprise site may also include additional network
components between Charter’s network and the enterprise. A complete discussion of the
configuration of these devices is beyond the scope of these Application Notes. However, it should be
noted that SIP and RTP traffic between the service provider and the enterprise must be allowed to
pass through these devices.

For confidentiality and privacy purposes, actual public IP addresses and DID numbers used during
the compliance test have been replaced with fictitious IP addresses and DID numbers throughout the
Application Notes.
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Figure 1: Avaya Interoperability Test Lab Configuration.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the compliance testing.

Equipment/Software

| Release/Version

Avaya

Avaya IP Office 500 V2

10.0.0.2.0 Build 10

Avaya IP Office DIG DCPx16 V2

10.0.0.2.0 Build 10

Avaya IP Office Phone 8 Analog card

10.0.0.2.0 Build 10

Avaya IP Office Manager

10.0.0.2.0 Build 10

Avaya Voicemail Pro Client

10.0.0.2.0 Build 29

Avaya IP Office Application Server
- Avaya WebRTC Gateway
- Avaya one-X Portal for IP Office

10.0.0.1.0 Built 53
10.0.0.1.0 Built 3
10.0.0.1.0 Built 16

Avaya 96x1 Series IP Deskphones (H.323)

Version 6.6302

Avaya 1140E IP Deskphones (SIP)

SIP1140e Ver. 04.04.23.00

Avaya Communicator for Windows 2.1.3.237
Avaya Communicator for Web 1.0.16.1718
Avaya Digital Deskphones 1408 R46
Avaya Digital Deskphones 9508 R59

Lucent Analog Phone

Charter Communications

Broadworks Broadsoft Application Server

AS_Rel 17.sp4_1.197

Acme Net-Net 4500 Series SBC

SCX6.2.0 MR-9 GA (Build 1014)

Adtran NetVanta 3430 Modular Access Router

R11.4.6.V

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500v2 and also when deployed with all configurations of IP Office Server Edition.
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5. Configure IP Office

This section describes the IP Office configuration required to interwork with Charter SIP Trunking
service. IP Office is configured through Avaya IP Office Manager (IP Office Manager) which is a
PC application. On the PC, select Start - Programs = IP Office & Manager to launch IP Office
Manager. Navigate to File > Open Configuration, select the proper IP Office from the pop-up
window, and log in with the appropriate credentials. A management window will appear as shown in
the next sections. The appearance of IP Office Manager can be customized using the View menu
(not shown). In the screenshots presented in this section, the View menu was configured to show the
Navigation pane on the left side and the Details pane on the right side. These panes will be
referenced throughout these Application Notes.

These Application Notes assume the basic installation and configuration of IP Office have already
been completed and are not discussed here. For further information on IP Office, please consult
References in Section 9.

5.1 Licensing

The configuration and features described in these Application Notes require the IP Office system to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a valid license
with sufficient “Instances” (trunk channels) in the Details pane.

IP Offices ‘ [ |
=& BOOTP (5) License | Remote Server|
{# Operator (3)
-7 [IPS00Y2 Main License Mode License Mormal

[H-*%37 System (1) . )

-7 Line (25) Licensed Version 10,0

-2 Control Unit (4) PLDS Host ID

-4 Extension (48) ) .

U___a User (50) PLDS File Status ~ Valid

(-5 Group (1)

-0 short Code (69) Feature Key Instances Status Expiration Date  Source o
@ Service (0)

(ol RAS (1) Avaya Softphone Licence M/ 100 Valid Never PLDS Noda

[]---@ Inceming Call Route (3) WMPro TTS (Scansoft) N/A 40 Valid Mever PLDS Moda
@ WAN Port (0) YMPro TTS Professional /& 40 Yalid Mewver PLDS Moda
- Directory (0) IPSec Tunnelling N/A 1 Valid Never PLDS Moda
£ Time Profile (0) . :

- ] Power User M/ 384 Valid Mewver PLDS Moda

{8 Firewall Profile (1) ] i

-l P Route (5) Avaya [P endpoints N/A 384 Valid Never PLDS Noda
-8 Account Code (0) IP500 Voice Networking Channels /& 32 Valid Mever PLDS Moda
-] License (90) SIP Trunk Channels [ Nsa |128 | valid | Never | PLDS Moda
-8 Tunnel (0) IP500 Universal PRI (Additional cha... N/A 100 Valid Never PLDS Noda

gj}.ﬁ ¢ g;‘;’ g'fhts ® CTlLink Pro NA 1 Valid Never PLDS Noda
- Location (0) Wave User /A 16 Valid Mever PLDS Moda
-8 Autherization Code (0) 3rd Party IP Endpeints M/ 384 Valid Never PLDS Moda
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5.2 System

Configure the necessary system settings. In an Avaya IP Office, the LAN2 tab settings correspond to
the Avaya IP Office WAN port (public network side) and the LANL1 tab settings correspond to the
LAN port (private network side). For the compliance test, the LANL1 interface was used to connect
Avaya IP Office to the enterprise private network (LAN), LAN2 was not used.

5.2.1 System - LAN1 Tab

In the sample configuration, IP500V2 Main was used as the system name. The LAN port connects
to Charter’s Modular Access Router, across the enterprise LAN (private) network. The LAN1
settings correspond to the LAN port in IP Office. To access the LAN1 settings, navigate to System
(1) = IP500V2 Main in the Navigation pane then in the Details pane navigate to the LAN1->
LAN Settings tab. The LANL1 settings for the compliance testing were configured with following

parameters:

e Setthe IP Address field to the LAN IP address, e.g. 10.64.70.60.

e Setthe IP Mask field to the LAN subnet mask, e.g. 255.255.255.0.

e All other parameters should be set according to customer requirements.
e Click OK to commit (not shown).

IP Offices

= IP500V2 Main

- K BOOTP (5)

+-i#% Operator (3)

=I-*=3 IP500V2 Main

— =7 System (1)

-5y IPS00V2 Main
+--F4 Line (25)

+ = Control Unit (4)
+

T

-y Extension (48)
o0-@  User (30)
+1ﬂ Group (1)
+-8% Short Code (69)
4B Service (0)
+-olly RAS (1)
+e Inceming Call Reute (3)
----- $8 WAN Port (0)
----- @ Directory (0)
----- £ Time Profile (0]
-} Firewall Profile (1)
+-Jfll IP Route (5)
----- Bl Account Code (0)
----- & License (90)
----- & Tunnel (0)
+)-§ User Rights (8)
- ARS (2)

| System ||-':'*N1| LANZ | DMS | Voicemail | Telephony | Directory Services | System Events
—

LAM Settings |‘ufoIP | Metwork Topology|

IP Address 10 64 70 60

IP Mask 255 . 255 . 255 0

Primary Trans. IP Address 0 0 i 0

RIP Mode INc-ne -
[7] Enable MAT

-

Mumber Of DHCP IP Addresses (200
DHCP Mode

) Server () Client ) Dialln @ Disabled

Advanced
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The VolIP tab as shown in the screenshot below was configured with following settings:

Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.

Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Charter.

Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register using
the SIP protocol.

Enter the Domain Name of the enterprise under Domain Name.

Verify the UDP Port and TCP Port numbers under Layer 4 Protocol are set to 5060.
Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

In the Keepalives section at the bottom of the page, set the Scope field to RTP-RTCP,
Periodic Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office to
send RTP keepalive packets at the beginning of the calls and every 30 seconds thereafter if
no other RTP traffic is present.

All other parameters should be set according to customer requirements.

Click OK to commit (not shown).

IP Offices = IP500V2 Main

T--x BOOTP (5)

-5 PS00V2 Main

+& Extension (48)
g User (30)

-4 Group (1)
#-@% Short Code (69)

| System [ LANL [Lan2 [ DNS | Voicemail | Telephony | Directory Services | System Events | sMTp | sMDR [veM [ volP | volP Security

Operator (3)

‘ LAN Se’ctingslé\fﬂ“:| H NetworkTopoIogy|

I H.323 Gatekeeper Enah\el
[ Auto-create Extension

Auto-create User H.323 Remote Extenzion Enable

< Contral Unit (4)
Disabled -

H.323 Signaling over TLS Remote Call Signaling Port 1720 -

SIP Trunks Enable

B Service (0)

-y RAS (1)

- Incoming Call Route (3)
40 WAN Port (0)

@= Directory (0]

SIP Registrar Enable

[ Auto-create Extension/User

SIP Domain Name

avaya.lab.com

5IP Remote Extension Enable

@ Firewall Profile (1)

i

-

a8 Account Code (0) upp UDP Port 5060 = Remote UDP Port 5060 =
% License (90)
& Tunnel (0) Layer 4 Protocol TCP TCP Port | 5060 = Remote TCP Port | 5060 =
3 User Rights (8) = —
§(. s (2)9 LS TLS Port  |5061 z Remote TLS Port  |5061 2
- Location (0) L . —
3% Authorization Code (0) Challenge Expiration Time (sec) 10 =
RTP
Port Mumber Range
Minimum 49152 = Maximum 53246 =
Port Mumber Range (NAT)
Minimum 49152 = Maximum 53246 =
Enable RTCP Moenitoring on Port 5005
RTCP collector IP address for phones 0 1] 0 0
Keepalives
Scope [RTP-RTCP ~| Periodic timeout 30
Initial keepalives IEnabIEd VI

Time Profile (0)
SIP Registrar FQDMN avaya.lab.com

[l 1P Route (5)
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In the Network Topology tab, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. In the compliance testing, it was set to Open Internet. With this
configuration, even though the default STUN settings are populated, they will not be used.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Setthe Public IP Address to the IP address assigned under the LAN Settings tab, e.g.,
10.64.70.60.

e Set the Public Port to 5060 for UDP.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices |E IP500V2 Main
oK gOOTtP (5(13) | system [ LANL |LAN2 | DNS | Voicemail | Telephony | Directory Semvices | System Events [ smTe [ smpr [vem [ velp | volP security
*_’ ‘u_" pera or o
-+ IP500V2 Main LAN Settings | ValP [ Network Topology |
Metwork Topolegy Discovery
£-T7 Line (25) STUN Server Address 699016813 STUN Port 3478 s
+-“ Control Unit (4)
-4 Extension (48) Firewall/NAT Type IOpen Internet 'I
+-f  User (50)
+a Group (1) Binding Refresh Time (sec) 300 5
8% Short Code (69) ——
@ Senice (0] Public IP Address 10 64 70 60 Run STUN Cancel
oy RAS (1)
+® Incoming Call Route (3) Public Port
-E) WAN Port (0) <
= Directory (0) uop 2060 =
Time Profile {0) &
TCP 5060 =
& Firewall Profile (1)
Kl 7 Route (5) TLs 5061 =
Bm Account Code (0)
; License (30) [] Run STUN on startup
il Tunnel (0)
i-fi User Rights (8)
- ARS (2)
-8 Location (0)
m Authorization Cede (0)
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5.2.2 System - Telephony Tab

Navigate to the Telephony = Telephony Tab in the Details pane, configure the following
parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfers to the PSTN via the SIP trunk to the service provider.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices

—

IP500V2 Main

& BOOTP(5)

# Operator (3)

System | LANL [ LAN2 [ DNS [ Voicemail | Telephony ] Directory Services | System Events [ sMTp | smDR [vem [ velp [ voIP security

B Telephony | Park & Page| Tones & Music| Ring Tones [ sM [ CaliLog [ TUI |
Analogue Extensions Companding Law
- Switch Line
tl-<2» Control Unit (4) Default Qutside Call Sequence [Normal ']
H-4& Extension (48)
H-§ User (50) Default Inside Call Sequence [R\ng Typel V] @ U-law @ U-Lawline
-5 Group (1) )
8% Short Code (69) Default Ring Back Sequence [ng Type2 '] - T
@ Service (0] Restrict Analegue Extension Ringer Voltage 0 ) w awne
H--o; RAS (1)

J@ Incoming Call Route (3)
- BF WAN Port (0)

- Location (0)
'm Authorization Code (0)

Ring Delay (sec)

Default Currency

Default Mame Pricrity

Media Connection Preservation
Phone Failback

Login Code Complexity

[ Enforcement
n

Complexity

Call Priority Promotion Time (sec) |Disabled

A

us

Favor Trunk

Disabled

o
e ]e]]

Manual

[] DSS Status

o Directory (1) Dial Delay Time (sec) 4 =
--aa Directory
411 Time Profile (0) Dial Delay Count 0 = Auto Hold
-} Firewall Profile (1) Dinl By Name
- Jill IP Route (5) Default Mo Answer Time (sec) 15 = 7
& Account Code (0) ) - Show Account Code
% License (90) Hold Timeout (sec) 0 =
il Tunnel {0} = | [ Inhibit Off-Switch Forward,/ Transfer
3& , User Rights (8) Park Timeout (sec) 300 =
JK. ARS (2) 5 = [ Restrict Metwork Interconnect

Include location specific information
[] Drop External Only Impromptu Conference
] Visually Differentiate External Call
[”] Unsupervised Analog Trunk Disconnect Handling
High Quality Conferencing
Digital/Analegue Auto Create User
[T] Directory Overrides Barring

[] Advertise Callee State To Internal Callers
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5.2.3 System - VoIP Tab

For Codec’s settings, navigate to the System (1) = IP500V2 Main in the Navigation pane, select
the VolP tab and configure the following parameters:

e The RFC2833 Default Payload field is new in IP Office release 10. It allows the manual
configuration of the payload type used on SIP calls that are initiated by the IP Office. The
default value 101 was used.

e For Codec Selection, select the codecs and codec order of preference on the right, under the
Selected column. The Default Codec Selection area enables the codec preference order to be
configured on a system-wide basis. The buttons between the two lists can be used to move
codecs between the Unused and Selected lists, and to change the order of the codecs in the
Selected codecs list. By default, all IP lines and phones (SIP and H.323) will use the system
default codec selection shown here, unless configured otherwise for a specific line or
extension. The example below shows the codecs used for IP phones (SIP and H.323), the
system’s default codecs and order was used.

e Click OK to commit (not shown).

IP Offices |E IP500V2 Main
- R B0OTP (5) | system [ LANL [LANZ |DNS [ Voicemail | Telephony | Directory Services | System Events | sMTP | smpR |vem fVelP |
+-¢% Operator (3)
= IP500V2 Main Ignore DTMF Mismatch For Phones
Systern (1)

1PS00V2 Main Allow Direct Media Within NAT Location

{ Line (25)

+1- Control Unit (4) |RFC2833 Default Payload 101 | :

+- Extension (48)

+: User (50) Available Codecs Default Codec Selection

+ﬂ Group (1) Unused Selected

&8 Short Code (69) W] G.711 ULAW 64K G722 64K >a> | |[G711 ULAW B4K

E':@ ?{Z’;‘"E @ 7] G711 ALAW 64K G711 ALAW 64K

: %1 (1) ol Roste 3 7] 6.722 64K G.729(a) 8K C5-ACELP
b1 \;;”N"”p':?t (oa) oute (3) ] G.729(a) 8K CS-ACELP G.723.1 6K3 MP-MLQ

W _

= Directony () G.723.1 6K3 MP-MLQ ex

Time Profile (0)

+ Firewall Profile (1)
+-illl IP Route (5)

i Account Code (0)
License (90)

+-§q User Rights (3)

- ARS (2)

""" & Location (0)

o ﬂ Authorization Code (0]

Note: The codec selections defined under this section (System — VoIP Tab) are the codecs selected
for the IP phones/extensions. The codec selections defined under Section 5.4.6 (SIP Line — VolP
tab) are the codecs selected for the SIP Line (Trunk).
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5.3 IP Route

In the reference configuration, the IP Office LANL1 interface and the private interface of the
Charter’s Modular Access Router resided on the same IP subnet, so an IP route was not necessary. In
an actual customer configuration, these two interfaces may be in different IP subnets, and in that
case an IP route would have to be created to specify the IP address of the gateway or router where
the IP Office needs to send the packets, in order to reach the IP subnet where the Charter Modular
Access Router resides.

To create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to reach the IP subnet where the Charter’s Modular Access Router resides
(if located in different subnets), on the left Navigation pane, right-click on IP Route and select
New.

e Set the IP Address and IP Mask to 0.0.0.0 to make this the default route.

o Set Gateway IP Address to the IP Address of the gateway/route used to route calls to the
public network (to the network where Charter’s Modular Access Router resides, if located in
different subnet), e.g., 10.64.70.1.

e Set Destination to LAN1 from the pull-down menu.

e Click OK to commit (not shown).

IP Offices |E 0.0.0.0

#- & BOOTP (3) IP Route

#-4 Operator (3)
-+ IPS00V2 Main IP Address 0 0 0 0

= IP500V2 Main IP Mask 0 0 0 0

- ine (25) Gateway IP Address = = z 1
EIE Control Unit (4)
*
n

-4y Extension (48) Destination LaNL

i-§  User (50)
"‘ﬂ Group (1) Metric 0
+-@% Short Code (69)
B Service (0)

ol RAS (1)

+® Incoming Call Route (3)
----- $8 WAN Port (0)

~-28 Directory (0)

! Time Profile (0)
Firewall Profile (1)

Prowy ARP

----- #m Account Code (0)
----- % License (90)

""" i Tunnel (0)

+1-§q User Rights (8)
+( ARS (2)

-8 Location (0)

------ ﬂ Authorization Code (0)
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5.4 SIP Line

A SIP Line is needed to establish the SIP connection between IP Office and the Charter SIP
Trunking Service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by Avaya IP
Office Manager to create a SIP Line. Follow the steps in Sections 5.4.1 and 5.4.2 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.3t0 5.4.7.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the Navigation
pane and select New > SIP Line. Then, follow the steps outlined in Sections 5.4.3t0 5.4.7

5.4.1 Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format. These
XML templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office Standard
Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates may be
generated. However, binary templates include all the configuration parameters of the Trunk,
including sensitive customer specific information. Therefore, binary templates should only be used
for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., C:\Temp) on the same computer where
IP Office Manager is installed. By default, the template file name will have the format <user
supplied text>.xml, where the <user supplied text> portion is entered during template file
creation.

Note — If necessary, the <user supplied text> portion of the template file name may be modified,
however the <user supplied text>.xml format of the file name must be maintained. For example,
an original template file Test.xml could be changed to Testl.xml. The template file name is
selected in Section 5.4.2, step 1, to create a new SIP Line.
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2. Import the template into IP Office Manager. From IP Office Manager, select Tools = Import
Templates in Manager.

File Edit View [ Tools | Help

2 E ] E Extension Renumber...
IPS00V2 Main Line Renumber...
Connect To... i
IP Offic
Export (3 =
“ BOOTP (3) SCM Service User Management
F-i# Operator (3) ]
=529 IP500V2 Main Busy on Held Validation
=47 Systern (1)
f Loy IPSOOVE M5N Configuration
T‘. Line (25) Print Button Labels
-2 Control Unit X
& Extension (4 Import Templates in Manager Il
g User (50) License Migration
-5f Group (1) [T TVTEtrie

A folder browser will open. Select the directory used in step 1 to store the template(s) (e.g.,
C:\Temp).

=

Browse For Folder Iﬁ

Select a folder to import templates from -

» ) ProgramData -
» . SUPPORT
» . swtools
» ) swwork
. Temp
| tmp
» Lo Trilogy
= Users &
4 I I
CK ] [ Cancel
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In the reference configuration, template files CharterlPO10.xml was imported. The template files
are automatically copied into the IP Office default template location, C:\Program Files\Avaya\lP
Office\Manager\Templates.

3. After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK.

Template Provisioning ﬁ

I.-' _"-.I Successfully imported templates to IP Office Manager from
v ChTemp

5.4.2 Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation pane, and select
New from Template->Open from file.

W —

IP Offices =
=& BOOTP (5) » || SIP Line Transport| SIP URI|VoIP | T38 Fax|SIP Credentials
4% Operator (3)
-+ IP500V2 Main Line Number 17 =
EI---*-;.J System (1)
w5y [PH00Y2 Main ITSP Domain Mame
E-F4| Line (25
T_ Lomm o] Dl mvwm Pl o e
..... . ::J Mew 3
..... [ |sP
..... w, 1) Cut Ctrl+X ’CI E
ou
..... " 1 —:é I:l:lp}" Ctrl+C
..... y, 7
..... ., 7 — Curley
..... W, 2| 75 Delete Ctrl+Del
""" :'[‘t I-; o Validate
..... T:; 2 Connect To.. Ctrl+T 0
""" T+ 2 Mew from Template 3 Open from file ||
..... o
T_' ‘ Export as Template
..... r‘[:.(l 2
. | B i II '\.\.rl.rrrr.r_'r OO
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Navigate to C:\Program Files\Avaya\lP Office\Manager\Templates (or C:\Program Files
(x86)\Avaya\lP Office\Manager\Templates), on the bottom right hand side chose Template Files
(*.xml) format and select the template, in this case CharterlPO10.xml was selected.

I Open \EI
@\:Jvl i PI Computer » Avaya eSOE () » Program Files (x86) » Avaya » IP Office » Manager » Templates &,l | Search Templates ol
Organize + New folder =~ 0 @

¥ Favorites - MName : Date medified Type Size
Bl Desktop = CharterlPO10xml 1/17/2017 7:41 AM XML Document 4 KB
4 Downloads

= Recent Places
/% Computer

£, Avaya eSOE (C)

s TOSHIBA (E:)

. S -
v|

- |Template Files (*xml)

File name:

[ Open l | Cancel

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK

-

Template Provisioning @

IOI Mew SIP Trunk created successfully using selected ternplate.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

IP Offices

- & BOOTP (5) -
+-i# Operator (3)
+IP5S00V2 Main

-=) Systemn (1)

o esap IPS00V2 Main
1

..

4

1] 4

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual

configuration shown in Sections 5.4.3 to 5.4.7.
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5.4.3 SIP Line - SIP Line Tab

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below:

e Leave the ITSP Domain Name blank. Note that if this field is left blank, then IP Office
inserts the ITSP Proxy Address from the Transport tab as the ITSP Domain in the SIP
messaging.

e Verify that URI Type is set to SIP.

e Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

o Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line. The time between SIP OPTIONS sent
by IP Office will use the Binding Refresh Time for LAN1, as shown in Section 5.2.1.

o Verify that Refresh Method is set to Auto.

o Verify that Timer (seconds) is set to On Demand.

e Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing
Supervised REFER to Never (see Sections 2.1).

e All other parameters should be set to default or according to customer requirements.
e Click OK to commit (not shown).

IP Offices | = SIP Line - Line 17
+a BOOTP (3) | B LiﬂelTransportlSIP URIl‘u‘oIP IT38 FaxlSIP CredentialslSIP AdvancedlEngineering|
% Operator (3)
=37 IP300V2 Main Line Number 17 - In Service v
System (1)
= IP500V2 Main |1TSP Domain Mame | Check 005 ]
Local Domain Name
_____ m |URI Type sIp | - | Seszion Timers
""" e 18 ; Refresh Method Auto
_____ ~, 19 Location |Cloud v|
""" " 20 Tirner (sec) On Demand
..... oy, 21
..... wy, 22
..... ", 23 Prefix
..... T-‘I 201 X X
_____ 17 202 Mational Prefix 1]
:::_j: ;gi 3 International Prefix 00
----- £ 205 Country Code Redirect and Transfer
..... 79 206 . .
_____ 7 207 Name Priority System Default - Incoming Supervised REFER |Ne\.rer
----- T4 208 i ;
----- T4 209 Description Service Provider Outgoing Supervised REFER |Ne\.rer
----- 17 210 Send 302 Moved Temporarily
::;_j o Outgoing Blind REFER
1
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5.4.4 SIP Line - Transport Tab

Select the Transport tab; configure the parameters as shown below:
e Setthe ITSP Proxy Address to the IP address of the inside interface (or private side)
assigned to Charter’s Modular Access Router, as shown on Figure 1.

e Setthe Layer 4 Protocol to UDP.
e Set Use Network Topology Info to LAN1 as configured in Section 5.2.
e Set the Send Port to 5060.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).
IP Offices ‘ = 8IP Line - Line 17
7R BOOTP (5) * | |SIP Line| Transport |SIp URI|VolP | T38 Fax|SIP Credentials | SIP Advanced|Engineering
+-g# Operator (3)
;'"’":;- IP500V2 Main |lTSP me}r Address  10.64.70.54 |
-5 Systern (1)
_ﬂw Main Metwork Configuration
""" 1 Layer 4 Protocol IUDP v‘ Send Port 5060 =
..... o 2
Use Metwork Topology Info ILAN 1 v‘ 5060
----- . 18
""" e 19 Explicit DNS Server(s] 0 0 0 0 0
----- "y, 20
----- g, 21 Calls Route via Registrar
----- y, 22
----- ~ 23
I.j: ;gé Separate Registrar
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5.4.5 SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept on
this line. Select the SIP URI tab, and then click the Add... button and the New Channel area will
appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry was edited. For
the compliance test, a single SIP URI entry was created that matched any DID number assigned to
an IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name to Use Internal Data.

e Set Identity under Identity to Auto.

e Set Header under Identity to P Asserted ID

e Set Send Caller ID under Forwarding and Twinning to Diversion Header.
e Set Diversion Header to Auto.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. The outgoing line group number is used in defining short codes for routing
outbound traffic to this line. For the compliance test, a new incoming and outgoing group 17
was defined that only contains this line (line 17).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

e Click OK to commit (not shown).

e Click OK to commit again (not shown).

IP Offices ‘ = SIP Line -Line 17
m R BOOTP (5) SIP Line| Transport|SIP URI [volP | 738 Fax|SIP Credentials| SIP Advanced |Engineering
f-47 Operator (3)
== IP500V2 Main URI Groups Local URI  Contact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls
2= Sysiepr;og\}z y 17 17 <Intemal> <Intemal> <Intesl>  Auto  PAI Diversion  Auto 0: <Non... 10
- ] zin
-] Line (25)
1
o 2
w18
w19
w20
: ;2 Edit URI
w 23 Local URL Use Internal Data -
7 200
% 202 Contact Use Internal Data -
17 203 )
7 204 Display Name Use Internal Data -
11205 Identity
17 206
7% 207 Identity Auto -
7 208
17 209 Header P Asserted ID =
7 210
7 211 Forwarding And Twinning
17 212 Qriginator
7 213 Number
T 214 .
THas Send Caller D {Dwersion Header | -
1 216
-+ Control Unit (4)
-4 Extension (48)
£ User (50)
o % Group (1) |D|versmn Header lAuto] i -
+ s 22;15?5e ©9) Registration lO: <MNone> -
-of RAS (1) Incoming Group 17 -
£3 e Incoming Call Route (3)
48 WAN Port (0) Outgoeing Group 17 -
- Directory (0)
7] Time Profile (0) Max Sessions 10
0@ Firewall Profile (1)
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5.4.6 SIP Line - VoIP Tab

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e Inthe sample configuration, the Codec Selection was configured using the Custom option,
allowing an explicit order of codecs to be specified for the SIP Line. The buttons allow
setting the specific order of preference for the codecs to be used on the SIP Line, as shown.
Charter only supports codec G.711ULAW 64K for audio.

e Select G.711 for Fax Transport Support (Refer to Section 2.1).

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e  Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on the
trunk.

e Check the PRACK/100rel Supported box, to advertise the support for reliable provisional
responses and Early Media to Charter.

e  Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices |E SIP Line - Line 17
+R BOOTP (5) ‘SIP LinelTransportlSIP URIIVDIP |T38 FaxlSIP Credentials | 5IP Advanced |Engineering
#--4% Operator (3)
2 IP500V2 Main VolP Silence Suppression
SfStIIe?gI]((]l\.?Z Main 1 Local Held Music
2t Line 23] CodecSelection | Custom | -]
: é Unused Selected Codec Lockdown
g;ﬂ ?;]?W bak w M Allow Direct Media Path
:: ;g g;;gtf:lﬁsé ﬁ;iﬁig Force direct media with phones
-y, 21 V| PRACK/100rel Supported
: g G711 Fax ECAN
T';I 201
1 202
4 203
11 204 >>>
’I’:‘, 205
11:;: ;g; Fax Transport Support |G‘?11 v|
;j ;gg DTMF Support [RFc2zz3 -
?1:;: ig Media Security |D\sah|ed "

Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs selected
for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System — VoIP tab) are
the codecs selected for the IP phones/extension (H.323 and SIP).
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5.4.7 SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. For outbound calls with privacy enabled, Avaya IP Office will replace
the calling party number in the From and Contact headers of the SIP INVITE message with
“anonymous”. IP Office can be configured to use the P-Preferred-ldentity (PPI) or P-Asserted-
Identity (PAI) header to pass the actual calling party information for authentication and billing
purposes. By default, IP Office will use the PPI header for privacy. To configure IP Office to use the
PAI header for privacy calls:

e Verify the Call Routing Method is set to Request URI.
e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).
IP Offices ‘ = SIP Line - Line 17
=K BOOTP (5) |SIP LmelTransportlSIP URI|VoIP |T38 FaxlSIP Credam:ials"SIP Advanced |Engineering‘
i Operator (3)
= = IPS00V2 Main Addressing Media
T - ,Sfrsiz?ﬂgdz Main Association Method |By Source IP address - Allow Empty INVITE
i--'F". K Send Empty re-INVITE
F Call Routing Method |REquE;t URI - Allow To Tag Change
Suppress DNS SRV Lookups P-Early-Media Support Mone
-y, 18 Send SilenceSupp=0ff
e 19 Identity
: ;S Use "phone-context” Media Connection W
g, 27 Add user=phone Preservation s
gy 23 Use + for International Indicate HOLD
:::: ;gé I Use PAI for Privacy v‘ I
17 203 Use Domain for PAL Call Contrel
Tj 204 Swap From and PAL/Diversion Call Initiation Timeout (s) n
I" igg Caller ID from From header

T‘. 207 Send From In Clear Call Queuing Timeout {mins) 5

T‘. 208 Cache Auth Credentials v Service Busy Response 486 - Busy Here
-1 209 User-Agent and Server Headers

1210 9 on No User Responding Send | 408-Request Timeout
g

T .
"%7‘. ;E send Lecation Info u Action on CAC Location Limit | Allow Voicemail
-4 213
Ty 74 au:;;;r:rss (Q.850 Reason
T4 215
17 216 Emulate NOTIFY for REFER
42 Control Unit (4) Mo REFER if using Diversion
44y Extension (48)
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5.5 Extension

In this section, an example of an Avaya IP Office Extension will be illustrated. In the interest of
brevity, not all users and extensions will be presented, since the configuration can be easily
extrapolated to other users and extensions. To add an Extension, right click on Extension then select
New = Select H323 or SIP (not shown).

Select the Extension tab. Following is an example of extension 1502; this extension corresponds to
an H.323 extension.

IP Offices | = H.323 Extension: 8012 1502
iy IPS00V2 Main « || Extension |\.r01p |
[T Line (25)
[ Control Unit (4) Extension ID 8012
(= |Extension (48)
..... A& 1011101 Base Extension 1502
----- 4 1021102
,,,,, & 1031103 Phone Password
""" 4 1041104 .
_____ & 1051105 Confirm Phone Password
""" & 106 1106 Caller Display Type On
----- & 1071107 Py lye
----- A8 1081108 Reset Volume After Calls ]
""" - 1091109
----- & 1101110 - Tree 0
0] T Avaya 9641
----- & 1111111 meiee pe g
----- A 1121112
----- & 1131113 Location | Automatic -
""" 4 1141114
..... & 1151115 Fallback As Remote Worker ’Auto v]
----- 4 1161116
----- ", 5008 1501 2| Module g
----- & 8012 1502|
0
----- & 251503 Port
""" & 261504
""" & 271505 Disable Speakerphone (]
----- 4 281506
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Select the VOIP tab. Use default values on VoIP tab. Following is an example for Extension 1502;
this extension corresponds to an H.323 extension.

By default, all IP phones (SIP and H.323) will use the system default codec selection configured
under the System VolP tab (Section 5.2.3), unless configured otherwise for a specific extension by
selecting Custom under Codec Selection on the screenshot shown below. The example below
shows the codecs used for IP phones (SIP and H.323).

IP Offices 1= H.323 Extension: 8012 1502

L% IPS00V2 Main “ | [Extension | VelP |

T3 Line (23)

[#-== Control Unit (4 [T] VolP Silence Suppression
-] Extension (48) IP Address 1] Q 1] 0

-4 101 1101 & Enable Faststart for
- 102 1102 MAC Address 00 0o 00 00 00 00 non-Avaya IP phones

o 103 1103
o 104 1104 Codec Selection System Default -l Out Of Band DTMF

z 105 1105 ] Local Tones
-4 106 1106

- 107 1107 G.72264K >33 G.711 ULAW 64K Allow Direct Media Path
oy 108 1108 G711 ALAW 64K

4y 109 1109 (G.729(a) 8K CS-ACELP
A 1101110 G.723.1 6K3 MP-MLQ

-~ 1111111
-4 1121112 s
-~ 1131113
-~y 114 1114
4 1151115
~p 116 1116
-, 8008 1501 e ne
N |
4y 251503
iy 261504
& 271505 TOM->IP Gain [Defautt -
e 281506
-~ 291507 1P->TDM Gain [Defautt -
- 30 1508
oy 311509 Supplementary Services [None V]
e 321510
-, 8009 1540 Media Security [Same as System (Disabled) -
~g, 8011 1541

Reserve License [None V]
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5.6 Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first navigate to User in the left Navigation

pane, and then select the name of the user to be modified in the center Group pane. In the example
below, the name of the user is “H323 Ext 1502”.

IP Offices

x

H323 ext 1502: 1502

1115 Extn1115
1116 Extn1116
1503 Extn1503analog
1504 Extn1504
1505 Extn1505
1506 Extn1506
1507 Extn1507
1508 Extn1508
1509 Extn1509
1510 Extn1510
1596 Extn1596
1597 Extn1597
1598 Extn1598
1599 Extn1599
1600 Extn1600
1601 Extn1601
1602 Extn1602
1603 Extn1603
1502 H323 ext 1502
1542 H323 ext 1542
1541 H323 ext1541
= 1540 IP H323 1540
i 1501 IP H323 9640
= 1552 Rem_W 5IP 1552
= 1570 =ipl 570
i 1571 sipl 571
i 1572 sipl 572
o 1575 sipl 575
i 1576 sipl 576

1580 sip1580
o 1595 Soft H323 1595
i 1550 Soft 5IP 1550
1557 WebRTC1557

i 1558 WebRTC1558

(-3 Group (1)
[-8% Short Code (69)
----- B Service (0)
ol RAS (1)
(- Incoming Call Route (3)
----- 2 WAN Port (0)
----- =x Directory (0)
----- £ Time Profile (0)
(-8 Firewall Profile (1)
G-l IP Route (5)
Bl Account Code (0)
----- % License (90)
""" & Tunnel (0)
-5 User Rights (8)
B ARS (2)
""" i3 Location (0)
----- m Authorization Code (0)

m,

|User |Voicemai| | DND | Short Codes | Source Numbers | Telephony | Ferwarding | Dial In |Voice Recording | Button Programming

MName

Password

Confirm Password
Unique Identity
Conference PIN
Confirm Audio Conference PIN
Account Status
Full Mame
Extension

Email Address
Locale

Priority

System Phone Rights

Profile

Device Type

P

H323 ext 1502

Enabled

1502

l

[s

[None

[Basic User

[[] Receptionist
Enable Softphone
Enable one-X Portal Services
Enable one-X TeleCommuter
[ Enable Remote Worker
[ Enable Communicator
Enable Mobile VoIP Client
Send Mohbility Email

Web Collaboration

[T Exclude From Directery

Avaya 9641
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In the example below, the name of the user is “Soft SIP 1550”. This is an Avaya IP Office Softphone
user, set the Profile to Power User and check Enable Softphone.

IP Offices |E Soft SIP 1550: 1550

""" 1115 Extn1115 o User I\c’oicemail | DMD | Short Codes | Source Numbers | Telephony | Ferwarding | Dial In | Voice Recording | Button Programming

----- 1116 Extn1116

----- 1503 Extnl503analog MName Soft SIP 1550

----- 1504 Extn1504

----- 1505 Extn1505 Password vese Q

----- 1506 Extn1506

""" 1507 Extn1507 Confirm Password sene

----- 1508 Extn1508 . .

..... 1509 Extn1509 Unique Identity

gég ;:g;g Conference PIN

""" 1597 Bxtnl567 Confirm Audio Conference PIN

----- 1598 Extn1598

""" 1599 Extn1599 Account Status Enabled -
15800 Extn1500

----- 1601 Extn1601 Full Mame

----- 1602 Extn1602

..... 1603 Extnl603 o Extension 1550

----- 1502 H323 ext 1502
----- 1542 H323 ext 1542
----- = 1541 H323 ext1541

Email Address

Locale [ ']
----- 1540 1P H323 1540
----- 1501 1P H323 9640 Priarity [5 v]
----- e 1552 Rem_W SIP 1552
----- e 1570 sipl570 Systermn Phone Rights ’None ']
----- 1571 sipl571
----- i 1572 sipl572 ) I
_____ i 1575 sipl575 Profile [Power User I ']
""" 1576 sipl576 = Receptionist
----- 1580 sip1580
..... ' 1595 Soft H323 1595 Enable Softphone
""" IlSjOSoﬂSlPlSSOl Enable one-X Portal Services
----- 1557 WebRTC1557
..... w1558 WebRTC1558 | Enable one-X TeleCommuter
-3 Group (1) i
58X Short Code (69) Enable Remote Worker
""" @ Service (0) Enable Communicator
B-alfg RAS (1)
E]---@ Incoming Call Route (3) Enable Mobile VoIP Client
----- £8 WAN Port (0) . )
“= Directory (0) [] Send Maobility Email
£ Time Profile [(0)] [] Web Collaboration
(-8 Firewall Profile (1)
-l IP Route (5)
mm Account Code (0) [] Exclude From Directory
B License (90)
----- % Tunnel (0) . R
&-§ User Rights (8) Device Type Unknown SIP device
- ARS (2)
----- &5 Location (0)
----- m Authorization Code (0) | &
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Select the Voice Mail tab. The following screen shows the VVoicemail tab for the user with extension
1502. The Voicemail On box is checked. VVoicemail password can be configured using the
Voicemail Code and Confirm Voicemail Code parameters. In the verification of these Application
Notes, incoming calls from Charter to this user were redirected to VVoicemail Pro after no answer.
Voicemail messages were recorded and retrieved successfully. Voice mail navigation and retrieval
were performed locally and from PSTN telephones to test DTMF using RFC 2833.

IP Offices E H323 ext 1502: 1502
""" 1115 Bl 115 “ || user I Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In | Voice Recording | Button Programming
""" 1116 Extn1116
----- 1503 Extn1503analog Voicemail Code sssnne Voicemail On
""" 1504 Extn1504
----- 1505 Extn1505 Confirm Voicemail Code  esessss [T Voicemail Help
""" 1506 Extn1506
----- 1507 Extn1507 Voicemail Email [T] Voicemail Ringback
----- 1508 Extnl508 Voreemail ol Readi
_____ 1509 Extn1509 Voicemail Email Reading

----- 1510 Extn1510
----- 1596 Extn1596
----- 1597 Extn1587
----- 1598 Extn1598
----- 1599 Extn1599
----- 1600 Extn1600

[] UMS Web Services

----- 1601 Extn1601 @ Off Copy Forward Alert

----- 1602 Extn1602

..... 1603 Extn1603 DTMF Breakout

----- 1502 H323 ext 1502 )

_____ 1542 H323 ext 1542 Reception/Breakout (DTMF 0) System Default () -

1541 H323 ext1541 0]

""" e 1540 1P H323 1540

..... = 1501 IP H323 9640 Breakout (DTMF 2) System Default () -
1552 Rern_W SIP 1552

..... e 1570 sipl570 v
..... - 1571 sipl 571 Breakout (DTMF3) e et i
..... e 1572 5ipl572 D
..... i 1575 sipl 575 Y
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Select the Mobility tab. In the sample configuration user 1502 was one of the users configured to
test the Mobile Twinning feature. The following screen shows the Mobility tab for User 1502. The
Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile Number field
is configured with the number to dial to reach the twinned telephone, including the dial access code
“9”, in this case 917864571234. Other options can be set according to customer requirements.

IP Offices

T H323 ext 1502: 1502*

1115 Extn1115
1116 Extn1116
1503 Extn1503analog
1504 Extn1504
1505 Extn1505
1506 Extn1506
1507 Extn1507
1508 Extn1508
1509 Extn1509
1510 Extn1510
1596 Extn1596
1597 Extn1597
1598 Extn1598
1599 Extn1599
1600 Extn1600
1601 Extn1601
1602 Extn1602
1603 Extn1603
1542 H323 ext 1542

e 1541 H323 ext1541

= 1540 IP H323 1540

= 1501 IP H323 9640

= 1552 Rem_W SIP 1552

1570 sipl370

= 1571 sipl571

i 1572 sipl572

= 1575 sipl575

= 1576 sipl576
1580 sip1580

= 1595 Soft H323 1595

= 1550 Soft 5IP 1550

-

Dial In | Voice Recording | Button Programmin Menu Programmin Mability | Group Membership | Announcements | SIP
2 9 2 2 2 P P

[T Internal Twinning
<MNone>
1
Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

Meohbility Features
Maobile Twinning

Twinned Mobile Number
(including dial access code)

917864571234

Twinning Time Profile <None> -

Mobile Dial Delay (sec) 2

Mobile Answer Guard (sec) |0 =
[] Hunt group calls eligible for mobile twinning
[] Forwarded calls eligible for mobile twinning
[] Twin When Logged Out

[7] one-X Mobile Client

Mobile Call Control

Mobile Callback

To program a key on the telephone to turn Mobil Twinning on and off, select the Button
Programming tab on the user, then select the button to program to turn Mobil Twinning on and off,
click on Edit = Emulation = Twinning (not shown). In the sample below, button 4 was
programmed to turn Mobil Twinning on and off on user 1502.

IP Offices ‘ 7 H323 ext 1502: 1502
""" g Eig 3:1112 i | Dial In | Voice Recording I Button Programming | Menu Pregramming | Mobility | Group Membership
""" § 1503 Bxtnl503analog Button .. Label Action Action Data
----- § 1504 Extn1504
,,,,, § 1505 Extn1505 1 Appearance a=
----- 3 1506 Extn1506 2 Appearance b=
----- § 1507 Extn1507 3 Appearance c=
----- i sopm I S S
----- § 1509 Extn1509 5
----- 3 1510 Extn1510
----- § 159 Extn1596 6
----- § 1597 Extn1597 7
----- § 1598 Extn1598 8
----- § 1599 Extn1599 g
----- § 1600 Extn1600 10
----- § 1601 Extn1601 1
----- 3 1602 Extn1602
----- § 1603 Exin1603 12
----- i 13
----- § 1542 H3Z3 ext 1542 14
----- f 1541 H323 ext1541 15
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Select the SIP tab, the values entered for the SIP Name and Contact fields are used as the user part
of the SIP URI in the “From” and “Contact” headers for outgoing SIP trunk calls. In addition, these
settings are used to match against the SIP URI of incoming calls without having to enter this number
as an explicit SIP URI for the SIP line (Section 5.4). The example below shows the settings for user
“H323 ext 1502”. The SIP Name and Contact are set to one of the DID numbers assigned to the
enterprise by Charter. In the example, DID number 3031231273 was used. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name.

If all calls involving this user should be considered private, then the Anonymous box may be
checked to withhold the Caller ID information from the network.

IP Offices |E H323 ext 1602: 1602°
L115 Bxtn1113 0 | Dial In | Voice Recording | Button Programming | Menu Programming | Mobility | Group Membership | Announcement;l SIP |Persona| Directory
1116 Extn1116
1503 Extn1503analog SIP Name 3031231273
1504 Extn1504
1505 Extn1505 SIP Display Mame (Alias) H323 ext1502
1506 Extn1506
1507 Extn1507 Contact 3031231273
1508 Extn1508
1509 Extn1509
1510 Extn1510 Anonymous
1586 Extn1596
1597 Extn1597
1598 Extn1598
1599 Extn1599
1600 Extn1600
1601 Extn1601
1602 Extn1602
1603 Extn1603
1542 H323 ext 1542
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5.7 Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt

groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for Call
Routing Method and SIP URI (Section 5.4.5) and the users SIP Name and Contact, already
populated with the assigned Charter DID numbers (Section 5.6).

From the left Navigation pane, right-click on Incoming Call Route and select New.

On the Details pane (not shown), under the Standard tab, set the parameters as show below:
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Default values may be used for all other parameters.

IP Offices

W
o
-

17

=& BOOTP (9)

¢ Operator (3
""‘".1' System (1)
&% Line (25)
-2 Contrel Unit (4)
(- Extension (48)
@ User (50)

-ﬂ Group (1)
E-8% Short Code (69)

-l RAS (1)

Bﬂb Incoming Call Route (3)
0

----- EB WAN Port (0)

----- @5 Directory (0)

----- £ Time Profile (0)
@8 Firewall Profile (1)
G-l IP Route (5)

----- Wl Account Code (0]
----- % License (90)

----- W Tunnel [0)

F-g5 User Rights (8)
B ARS (2)

""" & Location (0)

----- -m Authorization Code (0)

Standard I‘u'oice Recording | Destinations|

Bearer Capability

Line Group ID

[Any Voice

17

Inceming Number
Incoming Sub Address
Incoming CLI

Locale

Pricrity

Tag

Haold Music Socurce

Ring Tone Override

[

[l - Low

[System Source

Mone
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Under the Destinations tab, enter ““.” for the Default Value. This setting will allow the call
to be routed to any destination with a value on its SIP Name field, entered on the SIP tab of

that User, which matches the number present on the user part of the incoming Request URI.
e Click OK to commit (not shown).

IP Offices |E

+“ BOOTP(3) | Standard | Voice Recording I Destinations
+l-i# Operator (3]
—-+23[TP500V2 Main TimeProfile Destination

ey Systern (1) » | Default Value
#-T7 Line (25)

+ = Control Unit (4)
+-4 Extension (48)
=-§  User (50)

+ﬂ Group (1)

+- 9% Short Code (63)
@B Service (0)

ol RAS (]
Incoming Call Route (3)
P 1
5

@
@0

B WAN Port (1)

17

Fallback Extension

=]
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5.8 Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing can
be specified so that a call can re-route automatically if the primary route or outgoing line group is
not available. While detailed coverage of ARS is beyond the scope of these Application Notes, and
alternate routing was not used in the reference configuration, this section includes some basic screen
illustrations of the ARS settings used during the compliance testing.

5.8.1 Short Codes and Automatic Route Selection

To create the short code used for ARS, right-click on Short Code in the Navigation pane and select
New (not shown). The screen below shows the creation of the short code 9N used in the reference
configuration. When the Avaya IP Office users dialed 9 plus any number N, calls were directed to
Line Group 17 which configurable via ARS.

In the Code field, enter the dial string which will trigger this short code. In this case, 9N was
used (note that the semi-colon is not used here).

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

Set the Line Group ID to 50: Main to be directed to Line Group 17, which is configurable
via ARS.

Set the Locale to United States (US English).

Click the OK to commit (not shown).

IP Offices = 9N: Dial
B 41 + || Short Code
- PX %42
- @R *43 Code 9N
P *44
- P *45%ME Feature Dial
- =47 Telephone Mumber M
- P *48 . .
X *19 Line Group ID 50: Main
9S50 Locale United States (US English)
- *52 Force Account Code
- TSINE Force Authorization Code
s E23on]
- @ FMEDO
----- B Service ()
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The following screen shows a sample ARS configuration for the route 50: Main. Note the sequence
of X’s used in the Code field of the entries to specify the exact number of digits to be expected,
following the access code and the first set of digits on the string. This type of setting results in a
much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation pane and
click Add (not shown).
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 1N. The value N represents the additional number of digits dialed
by the user after dialing 1 (The 9 will be stripped off).
e Setthe Line Group ID to the Line Group number being used for the SIP Line, in this case
Line Group ID 17 was used.
e Set Locale to United States (US English).
e Click OK to commit.

Edit Short Code
Code 100000000,
Feature | Dial -
Cancel
Telephone Mumber 1N
Line Group |D 17 -
Locale United States (LS English) -
Force Account Code
Force Authorization Code
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The following screenshot shows the ARS dial pattern entry after it was added.

IP Offices = Main
K BooTP (5 ARS
Operator (3)
=437 TP500V2 Main ARS Route ID 50 Secondary Dial tone
[H--%37 System (1)
[-F7 Line (25 -
= T_ CI;‘:t(rnl)Umt ) Route Mame Main [SYStE"‘TU"E
[+ Extension (48]
- User (50) Dial Delay Time System Default (4) Check User Call Barring
[-53@ Group (1)
(-8 Short Code (69) .
@ Service (0) Description
ol RAS (1)
[E] @ Incoming Call Route (3)
@ WAN Port (0] In Service Qut of Service Route [<Nona> vl
@& Directory (0) l
E:N Tirme Profile (0)
@ Firewall Profile 1) Time Profile <None> ————— Outof Hours Route [<None> -
(-l IP Route (5)
@8 Account Code (0) l
W License (90)
& : L;::‘I;I(Sis @ Code Telephone Number F%ature Line Greup ID - Add...
R e 16X 16N Dial 17
i LI 1N Dial 17 hn Remove
; " Outbound Fax ZHOOCKKK 2N Dial 17 \E| :
&5 Location (0) a1 a11 Dial 7 g (L
m Authorization Code (0) 611 611 Dial 17
GO0 6N Dial 17
BLIOCOMKK 81N Dial 22 52
< | mn 3
| l
30 .| = Alternate Route <None> 'I
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5.9 Save Configuration

When desired, send the configuration changes made in Avaya IP Office Manager to the Avaya IP
Office server in order for the changes to take effect.

Navigate to File->Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

Once the configuration is validated, a screen similar to the following will appear, with either the
Merge or the Immediate radio button chosen based on the nature of the configuration changes made
since the last save. Note that clicking OK may cause a service disruption due to system reboot. Click
OK if desired.

r

Save Configuration El [=] @

IP Office Settings
IPS00V2 Main

Configuration Reboot Mode
@ Merge

Immediate

When Free

Timed

Reboot Time

09:56

Call Barring

0] 4 l | Cancel | | Help
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6. Charter Spectrum Enterprise SIP Trunking Service
Configuration on legacy Charter Communications Platform

To use the Charter Spectrum Enterprise SIP Trunking Service offering on legacy Charter
Communications Platform, a customer must request the service from Charter Communications using
the established sales processes. The process can be started by contacting Charter Communications
via the corporate web site at: https://business.spectrum.com/content/sip-trunking or call 888-692-
8635.

During the signup process, Charter Communications and the customer will discuss details about the
preferred method to be used to connect the customer’s enterprise network to Charter’s network.
Charter Communications will provide IP addresses, Direct Inward Dialed (DID) numbers to be
assigned to the enterprise, etc. This information is used to complete the Avaya IP Office
configuration discussed in the previous sections.

As previously noted, as a required component of the Charter Spectrum Enterprise SIP Trunking
Service offering on legacy Charter Communications Platform, Charter Communications will install a
Modular Access Router at the customer premises (enterprise site). Charter Communications will
perform the initial configuration and maintenance as required. The Modular Access Router will be
considered Customer Premises Equipment (CPE).
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7. Verification and Troubleshooting

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly. This section also provides a list of useful troubleshooting tips that can be
used to troubleshoot the solution.

7.1 Verification Steps

The following steps may be used to verify the configuration:

e Verify that endpoints at the enterprise site can place calls to PSTN and that calls remain
active for more than 35 seconds. This time period is included to verify that proper routing of
the SIP messaging has satisfied SIP protocol timers.

o Verify that endpoints at the enterprise site can receive calls from PSTN and that calls can
remain active for more than 35 seconds.

e Verify that the user on the PSTN side can end an active call by hanging up.

e Verify that an Avaya endpoint at the enterprise site can end an active call by hanging up.

7.2 Protocol Traces

The following SIP message headers are inspected using sniffer trace analysis tool:
Request-URI: Verify the request number and SIP domain.

From: Verify the display name and display number.

To: Verify the display name and display number.

P-Asserted-Identity: Verify the display name and display number.
Privacy: Verify privacy masking with “user, id”.

Diversion: Verify the display name and display number.

The following attributes in SIP message body are inspected using sniffer trace analysis tool:
Connection Information (c line): Verify IP addresses of near end and far end endpoints.
Time Description (t line): Verify session timeout value of near end and far end endpoints.
Media Description (m line): Verify audio port, codec, DTMF event description.

Media Attribute (a line): Verify specific audio port, codec, ptime, send/ receive ability,
DTMF events.
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7.3 IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections. Launch
the application from Start - Programs - IP Office - System Status on the PC where IP Office
Manager is installed, log in with the proper credentials.

S mroresrersme I )
AVAyA IP Office System Status

Help Exit About

Online |offine

Logon

Control Unit IP Address: [ElE-ER:]

Services Base TCP Port: Elaf{iE3

User Name: NEEtskE

Password:

Auto reconnect

Secure connection
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e Select the SIP Line of interest from the left pane. On the Status tab in the right pane, verify
that the Current State is Idle for each channel (assuming no active calls at present time).

AVAYA IP Office System Status

Help Snapshot Off Exit About

Status  Utiization Summary Alarms

5

SIP Trunk Summary
Line Service State: In Service
Peer Domain Name: sip:/ff10.64.70.54
:i Resolved Address: 10.64.70,54
- Line Mumber: 17
Mumber of Administered Channels: 10
Mumber of Channels in Use: 0
Administered Compression: G711iMu
Enable Faststart: Ooff
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocal: UDF
SIP Trunk Channel Licenses: 128 . 0%
SIP Trunk Channel Licenses in Use: 0
SIP Device Features:
rrent Time in  Rem Cou.. ) er Party  Directi... Round e Transmit Trans...
State Media A... or Dia... onCa TripD... Jitter P Jitter
1 Idle |1day...
2 Idle |3day...
3 Idle |&day...
4 Idle |6day...
5 Ide |&day...
[ Idle |&day...
7 Idle |6day...
8 Idle |6&day...
9 Idle |&day...
10 Ide |6 day..
Trace [ Trace All ] [ Pause ] [ Fing ] Call Details Graceful Shutdown ] [ Force Out of Service ] [ Print...
Online
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e Select the Alarms tab and verify that no alarms are active on the SIP Line.

IP Office System Status

Help Snapshot LogOff Exit About

Status  Utlization Summary Alarms

Alarms for Line: 17 SIP sip://10.64.70.54

Last Date Of Error Occurrences Error Description

Clear Clear Al Graceful Shutdown ] [ Force Out of Service Print... Save As...

4:14:25 PM

Online
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7.4 |IP Office Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs = IP Office -
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office SysMonitor - [STOPPED]
File Edit “iew Filkers Status Help

=8| »8T| x|V @ ==

' F4 4

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting to the desired color.

All Settings (=234
T1 | wComp | wPM | weM | son | ssl | Jade |
&TM | cal | DTE | EConf | FiameRelsy | GOD | H323 | Inteface |
ISDM | F.ew/Lamp | Directory | Media | FRF | Rz | Ralting | Services  SIP |System|
Ewventsz
W Sip |veboze - [~ STUN [~ SIP Dect
FPackets
[~ SIP Reg/Opt Rx [~ SIP Mizc Rx
[~ SIPReg/Opt Tx [~ SIP Mizc Tx
[~ SIPCallRx [~ Crm Motify Fx
[~ SIPCallTx [~ Crm Motify Tx
¥ Sip Bz [~ hex IP Filter [nnn.ninn. i, nnn)
¥ Sip Tx ™ hex |
Default hll‘ Clear All | Tab Elear.f-‘all‘ Tab Sethll‘ [S—
Sl ‘ Lot | Load Parial File‘ S 2 Hl: |
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8. Conclusion

These Application Notes describe the procedures required to configure SIP trunk connectivity
between Avaya IP Office 10.0 to support Charter Spectrum Enterprise SIP Trunking Service on
legacy Charter Communications Platform, as shown in Figure 1.

Interoperability testing was completed successfully with the observations/limitations outlined in the
scope of testing in Section 2.1 as well as under test results in Section 2.2.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 43 of 45
SPOC 2/8/2017 ©2017 Avaya Inc. All Rights Reserved. CharterlPO10



9. References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] Avaya IP Office Platform Solution Description, Release 10.0.0.1, September 2016.

[2] Avaya IP Office Platform Feature Description, Release 10.0, August 2016.

[3] IP Office Platform 10.0 Deploying Avaya IP Office Platform IP500 V2, Document Number 15-
601042, Issue 31m, 01 December 2016.

[4] Administering Avaya IP Office Platform with Manager, Release 10.0, September 2016.

[5] IP Office Platform 10.0 Using Avaya IP Office Platform System Status, Document 15-601758,
Issue 11e, 07 July, 2016.

[6] IP Office Platform 10.0 Using IP Office System Monitor, Document 15-601019, Issue 08b, 25
November, 2016.

[7] Using Avaya Communicator for Windows on IP Office, Release 10, August 2016.

[8] Administering Avaya Communicator on IP Office, Release 10.0, Issue 01.01, August 2016.

[9] Using Avaya Communicator for Web, Release 1.0, Issue 1.0.6, May 2016.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 44 of 45
SPOC 2/8/2017 ©2017 Avaya Inc. All Rights Reserved. CharterlPO10


http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/

©2017 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.
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